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Chapter 1. Troubleshooting basics

To troubleshoot a problem, gather information about the problem for IBM® Software Support, use logging
data, and consult the lists of identified problems and workarounds.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide. For other
problem-solving options, see [Chapter 4, “Support information,” on page 43.

You can resolve some problems by ensuring that your system matches the system requirements. The most
up-to-date requirements are in the [Software product compatibility reports| (http://
publib.boulder.ibm.com/infocenter/prodguid /v1r0/clarity /index.html).

The following activities can help you find a solution to the problem you are having:

+ [“Gathering product information for IBM Software Support”|

* [“Using logging” on page 2|

+ [“Consulting the lists of identified problems and workarounds” on page 2|

Gathering product information for IBM Software Support

Before contacting IBM Software Support about a problem you are experiencing with this product, gather
the information shown in

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files Collect trace log files from failing systems. Most logs are
located in a logs subdirectory on the host computer. See
[“Principal trace log files” on page 7| for lists of all trace
log files and their locations.

For general information about the IBM Tivoli®
Monitoring environment, see the Tivoli Enterprise Portal
User's Guide.

Lotus Domino information Version number and patch level
Operating system Operating system version number and patch level
Messages Messages and other information displayed on the screen

© Copyright IBM Corp. 2005, 2016 1
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Table 1. Information to gather before contacting IBM Software Support (continued)

Information type Description

Version numbers for IBM Tivoli Monitoring Version number of the following members of the
monitoring environment:

» IBM Tivoli Monitoring. Also provide the patch level, if
available.

¢ Lotus® Domino® agent

To find these version and patch numbers, use the
following steps depending on your operating system:

* UNIX
1. On the command line, type
install_dir/bin/cinfo

2. Type 1 to show the products installed and the
versions.

¢ Windows

In Manage Tivoli Monitoring Services, click Browse
Settings.

_OR-
Look in install _dir/InstallITM/kincinfo.

Screen captures Screen captures of incorrect output, if any

(UNIX systems only) Core dump files If the system stops on UNIX systems, collect the core
dump file from the install_dir/bin directory, where
install_dir is the directory where you installed the
monitoring agent.

You can use the pdcollect tool to collect the most commonly used information from a system. This tool
gathers log files, configuration information, version information, and other data. For more information
about using this tool, see “pdcollect tool” in the IBM Tivoli Monitoring Troubleshooting Guide.

For information about working with IBM Software Support, see [[BM Support Portal Service Requests and]
(http:/ /www.ibm.com/support/entry/portal/Open_service_request/Software/
Software_support_(general)).

Using logging

Logging is the primary troubleshooting feature in the monitoring agent. Logging refers to the text
messages and trace data that is generated by the agent. Messages and trace data are sent to a file.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See [Chapter 2, “Trace logging,”|

for more information.

Consulting the lists of identified problems and workarounds

Known problems are organized into types such as those in the following list to make them easier to
locate:

* Installation, configuration, uninstallation

Remote deployment

Agent

Workspace
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e Situation

See [Chapter 3, “Problems and workarounds,” on page 19| for information about symptoms and detailed
workarounds for these types of problems.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.
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Chapter 2. Trace logging

Trace logs are used to capture information about the operating environment when component software
fails to operate as designed.

The principal log type is the RAS (Reliability, Availability, and Serviceability) trace log. These logs are in
the English language only. The RAS trace log mechanism is available for all components of IBM Tivoli
Monitoring. Most logs are located in a logs subdirectory on the host computer. See the following
information to learn how to configure and use trace logging:

* [“Principal trace log files” on page 7|

+ [“Examples: Using trace logs” on page 11|

* |“Setting RAS trace parameters by using the GUI” on page 12|

Note: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1."

IBM Software Support personnel use the information captured by trace logging to trace a problem to its
source or to determine why an error occurred. All components in the IBM Tivoli Monitoring environment
have a default tracing level. The tracing level can be changed on a per-component level to adjust the type
of trace information collected, the degree of trace detail, the number of trace logs to be kept, and the
amount of disk space used for tracing.

Overview of log file management

Knowing the naming conventions for log files helps you to find the files.

Agent log file naming conventions

[Table 2 on page 7| provides the names, locations, and descriptions of IBM Tivoli Monitoring general RAS1
log files. The log file names for the Lotus Domino agent adhere to the following naming convention:

Windows systems
hostname_productcode_program_HEXtimestamp-nn.log

Linux and UNIX systems
hostname_productcode program_HEXtimestamp-nn.Tlog
Where:

hostname
Host name of the computer where the monitoring component is running.

productcode
Two-character product code. For IBM Tivoli Composite Application Manager Agent for Lotus
Domino, the product code is gb.

program
Name of the program being run.

HEXtimestamp
Hexadecimal time stamp representing the time at which the program started.

nn Rolling log suffix.

© Copyright IBM Corp. 2005, 2016 5



Examples of trace logging

The Monitoring Agent for Lotus Domino is a multi-instance agent that has logs for the following files:

* kgbagent.exe

* kgbclient.exe

* kgbiwevent.exe

* kgbstart.sh (UNIX and Linux only)

> LGO

When you create an instance name on Windows operating systems, the kgbagent.exe is copied to create
an instance-specific copy. If the instance name is amsc282c, then kgbagent.exe is copied to
kgbagent_amsc282c.exe. The same thing happens for kghclient.exe, which is copied to

kgbclient_amsc282c.exe. On UNIX and Linux operating systems, when you create an instance, the files
are not copied to a new name. Each instance has its own log.

For example, if a Lotus Domino agent is running on the Windows system "server(01", the RAS log file for
that agent might be named as follows:

server0l_gb_kgbagent_437fc59-01.10g

When a multi-instance agent such as the Monitoring Agent for Lotus Domino creates a log file, the file is
named as follows: hostname_pc_instance_name_kgbclient_instance_name_starttime-number.log For
example: AMSC282_gb_amsc282_KGBCLIENT_amsc282_45labecb-01.10g

Often, the host name and the instance name are the same. Also, the client name might contain the
instance name, which helps you differentiate among the many clients that might be running if many
instances of the agent running. When you have multiple instances running, it looks like the same string is
displayed in the log file name multiple times.

As the program runs, the first log (11n=01) is preserved because it contains program startup information.
The remaining logs "roll." In other words, when the set of numbered logs reach a maximum size, the
remaining logs are overwritten in sequence.

Each time a program is started, a new time stamp is assigned to maintain a short program history. For
example, if the Lotus Domino agent is started twice, it might have log files as follows:

* kgbagent.exe
- Windows systems
hostname_gb_instance name_kgbagent_timestamp-nn.log
For example:AMSC282_gb_amsc282c_kgbagent_45267ef7-01.10g
— UNIX or Linux systems
hostname_gb_instance_name_kgbagent_timestamp-nn.log
For example:amsaix20_gb_aix20_kgbagent_45267ef7-01.10g
* kgbclient.exe
— Windows systems
hostname gb_instance _name KGBCLIENT instance name _timestamp-nn.Tlog
For example:AMSC282_gb_amsc282c_KGBCLIENT amsc282c_45267ef7-01.10g
- UNIX or Linux systems
hostname gb_instance _name_kgbclient timestamp-nn.log
For example:amsaix20_gb_aix20_kgbclient_45267ef7-01.70g
* kgbiwevent.exe
- Windows systems
hostname_gb_instance_name _kgbiwevent_timestamp -nn.log
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For example:AMSC282_gb_serverlamsc282_kgbiwevent_4526ad8f-01.10g
- UNIX or Linux systems
hostname _gb_instance_name_kgbiwevent timestamp-nn.log
For example:amsaix20_gb_aix20_kgbDiwevent_aix20_45267ef7-01.log
* kgbstart.sh
— UNIX or Linux only systems
kgbstart_instance_name.log
For example:kghstart_pa2kk.Tog

Other logs, such as logs for Take Action command logs, have a similar syntax such as in the following
Windows example: host_productcode_takeactioncommand.log. Only one log file is produced per Take
Action command.

Note: When you communicate with IBM Software Support, you must capture and send the RAS]1 log
that matches any problem occurrence that you report.

Principal trace log files

Trace log files are located on various systems.

contains locations, file names, and descriptions of trace logs that can help determine the source of
problems with agents.

Table 2. Trace log files for troubleshooting agents

System where log is located File name and path Description
On the Tivoli Enterprise Monitoring |. wWindows: The IBM Tivoli Provides details about products that
Server Monitoring timestamp.log file in |ar€ installed.

the install_dir\Instal1ITM path dN(;telerzce lofgging is enabled by
. UNIX: The efault. A contiguration step is not

candle_installation.log file in required to enable this tracing.
the install_dir/logs path

* Linux: The
candle_installation.log file in
the install_dir/logs path

On the Tivoli Enterprise Monitoring | The Warehouse_Configuration.log Provides details about the
Server file is in the following location on configuration of data warehousing
Windows systems: for historical reporting.

install _dir\InstallITM
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located

File name and path

Description

On the Tivoli Enterprise Monitoring
Server

The name of the RAS log file is as
follows:

* Windows: install _dir\logs\
hostname_ms_timestamp-nn.log

* UNIX: install _dir/logs/
hostname_ms_timestamp-nn.log

* Linux: install_dir/logs/
hostname_ms_timestamp-nn.log

Note: File names for RASI logs
include a hexadecimal time stamp.

Also on UNIX systems, a log with a
decimal time stamp is provided:
hostname_gb_timestamp.log and
hostname_gb_timestamp.pidnnnnn in
the install_dir/logs path, where
nnnnn is the process ID number.

Traces activity on the monitoring
server.

On the Tivoli Enterprise Portal Server

The name of the RAS log file is as
follows:

* Windows: install_dir\logs\
hostname_cq_HEXtimestamp-nn.log

* UNIX: install_dir/logs/
hostname_cq_HEXtimestamp-nn.log

* Linux: install dir /logs/
hostname_cq_HEXtimestamp-nn.log

Note: File names for RASI logs
include a hexadecimal time stamp.

Also on UNIX systems, a log with a
decimal time stamp is provided:
hostname_gb_timestamp.log and
hostname_gb_timestamp.pidnnnnn in
the install_dir/1ogs path, where
nnnnn is the process ID number.

Traces activity on the portal server.

On the Tivoli Enterprise Portal Server

The teps_odbc.10g file is located in
the following path:

* Windows: install_dir\Instal1ITM
* UNIX: install_dir/logs
e Linux: install_dir/logs

When you enable historical reporting,
this log file traces the status of the
warehouse proxy agent.

8 IBM Tivoli Composite Application Manager Agent for Lotus Domino Troubleshooting Guide




Table 2. Trace log files for troubleshooting agents (continued)

System where log is located

File name and path

Description

On the computer that hosts the
monitoring agent

The RASI log files are as follows:

* Windows: hostname
_gb_instance_name_kgbagent
HEXtimestamp-nn.Tlog in the
install_dir\tmaitmé\logs
directory

* Windows:
hostname_gb_instance_kgbagent
HEXtimestamp-nn.log in the
install_dir\tmaitm6\1logs
directory

* UNIX:
hostname_gb_instance_name_
kgbagent_
HEXtimestamp-nn.Tlog in the
install_dir/1ogs directory

* Linux:
hostname_gb_instance_name_
kgbagent_
HEXtimestamp-nn.log in the
install_dir/1ogs directory

* UNIX: hostname_gb_instance_
HEXtimestamp-nn.log in the
install_dir/logs directory

Also on UNIX, a log with a
decimal time stamp is provided:
hostname_gb_timestamp.log and
hostname_gb_timestamp.pid
nnnnn in the install_dir/logs
path, where nnnnn is the process
ID number.

These logs are in the following
directories:
* Windows: install dir\tmaitmé\
logs
* UNIX: install _dir/logs
* Linux: install_dir/logs
On Linux systems, the following
additional logs are provided:
— hostname_gb_timestamp.Tog
— hostname_gb_timestamp.
pidnnnnn in the
install_dir/1ogs path, where
nnnnn is the process ID number

Traces activity of the monitoring
agent.

See[Table 2 on page 7| for the
locations of the Lotus Domino agent
logs.

Chapter 2. Trace logging
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located

File name and path

Description

On the computer that hosts the
monitoring agent

The agent operations log files are as
follows:

instance_hostname_
GB.LGO is the current log created
when the agent is started.

instance_hostname_
GB.LG1 is the backup of the previous
log.

These logs are in the following
directory depending on the operating
system that you are using:

* Windows: install_dir\tmaitmé\
logs

* Linux: install_dir/logs
* UNIX: install _dir/logs

For the Lotus Domino agent:

* Windows:
instance_name_hostname_GB_.LGO
For example:
amsc282B_AMSC282_GB.LGO

* UNIX or Linux:
instance_name:hostname.
domain_name_depending on_
0S_settings_.LGO
For example:

aix20:amsaix20.tivlab.raleigh.
ibm.com:GB.LGO

aix202:amsaix20.tivlab.raleigh.
ibm.com:GB.LGO

aix202a:amsaix20.tivlab.raleigh.
ibm.com:GB.LGO

Shows whether the agent could
connect to the monitoring server.
Shows which situations are started
and stopped, and shows other events
while the agent is running. A new
version of this file is generated every
time the agent is restarted.

IBM Tivoli Monitoring generates one
backup copy of the *.LGO file with
the tag .LG1. View the .LG1 tag to
learn the following details regarding
the previous monitoring session:

* Status of connectivity with the
monitoring server

* Situations that were running

¢ The success or failure status of
Take Action commands

If instance_name:hostname.domain_name
is greater than 32 characters, the
characters that are farthest to the
right are truncated from the domain
name.

On the computer that hosts the
monitoring agent

The Take Action command log files
are as follows:

* host_gb_instance_
takeactioncommand.10og

The logs are in the following
directories:

* Windows: install dir\tmaitm6\
logs

* UNIX: install _dir/logs
* Linux: install_dir/logs

Traces activity each time a Take
Action command runs. For example,
when a hypothetical start_command
Take Action command runs, IBM
Tivoli Monitoring generates a
start_command.1og file.
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located File name and path |Description

Definitions of variables:

* timestamp is a time stamp with a format that includes year (y), month (m), day (d), hour (h), and minute (m), as
follows: yyyymmdd hhmm

* HEXtimestamp is a hexadecimal representation of the time at which the process was started.

* install_dir represents the directory path where you installed the IBM Tivoli Monitoring component. install_dir can
represent a path on the computer that hosts the monitoring system, the monitoring agent, or the portal.

* instance refers to the name of the database instance that you are monitoring.
* instance_name refers to the name of the agent instance.
* hostname refers to the name of the computer on which the IBM Tivoli Monitoringcomponent runs.

* nn represents the circular sequence in which logs are rotated. this value includes a range from 1 - 5, by default.
The first is always retained because it includes configuration parameters.

For more information about the complete set of trace logs that are maintained on the monitoring server,
see the IBM Tivoli Monitoring Installation and Setup Guide.

Examples: Using trace logs

You can open trace logs in a text editor to learn some basic facts about your IBM Tivoli Monitoring
environment.

IBM Software Support applies specialized knowledge to analyze trace logs to determine the source of
problems. The following examples are from the Tivoli Enterprise Monitoring Server log.

Example one
This excerpt shows the typical log for a failed connection between a monitoring agent and a
monitoring server with the host name serverla:
(Thursday, August 11, 2005, 08:21:30-{94C}kdc10c1.c,105,"KDCLO_ClientLookup") status=1c020006,
"location server unavailable", ncs/KDC1_STC_SERVER_UNAVAILABLE
(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1157,"LookupProxy") Unable to connect to
broker at ip.pipe:: status=0, "success", ncs/KDC1 STC 0K
(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1402,"FindProxyUsinglLocallLookup") Unable
to find running CMS on CT_CMSLIST <IP.PIPE:#serverla>

Example two
The following excerpts from the trace log for the monitoring server show the status of an agent,
identified here as "Remote node." The name of the computer where the agent is running is
SERVER5B:

(42C039F9.0000-6A4: kpxreghb.cpp, 649, "HeartbeatInserter") Remote node SERVER5B:GB is ON-LINE.

(42C3079B.0000-6A4:kpxreghb.cpp, 644, "HeartbeatInserter") Remote node SERVER5B:GB is OFF-LINE.

See the following key points about the preceding excerpts:

* The monitoring server appends the two-character product code to the server name to form a
unique name (for example, SERVER5B:vim ) for this instance of the agent. By using this unique
name, you can distinguish multiple monitoring products that might be running on SERVERS5B.

* The log shows when the agent started (ON-LINE) and later stopped (OFF-LINE) in the
environment.

* For the sake of brevity, an ellipsis (...) represents the series of trace log entries that were
generated while the agent was running.

* Between the ON-LINE and OFF-LINE log entries, the agent was communicating with the
monitoring server.
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¢ The ON-LINE and OFF-LINE log entries are always available in the trace log. All trace levels
that are described in |“Setting RAS trace parameters by using the GUI”| provide these entries.

On Windows systems, you can use the following alternate method to view trace logs:

1. In the Windows Start menu, click Program Files > IBM Tivoli Monitoring > Manage Tivoli
Enterprise Monitoring Services. The Manage Tivoli Enterprise Monitoring Services window is
displayed.

2. Right-click a component and click Advanced > View Trace Log in the menu. For example, if you
want to view the trace log for the agent, right-click the name of that agent in the window. You can
also use the viewer to access remote logs.

Note: The viewer converts time stamps in the logs to a format that is easier to read.

RAS trace parameters

Pinpoint a problem by setting detailed tracing of individual components of the monitoring agent and
modules

See ["Overview of log file management” on page 5|to ensure that you understand log rolling and can
reference the correct log files when you manage log file generation.

Setting RAS trace parameters by using the GUI

On Windows systems, you can use the graphical user interface to set trace options.
About this task

The IBM Tivoli Composite Application Manager Agent for Lotus Domino uses RAS] tracing and
generates the logs described in [Table 2 on page 7} The default RASI trace level is ERROR.

Procedure
1. Open the Manage Tivoli Enterprise Monitoring Services window.

2. Select Advanced > Edit Trace Parms. The Tivoli Enterprise Monitoring Server Trace Parameters
window is displayed.

3. Select a new trace setting in the pull-down menu in the Enter RAS1 Filters field or type a valid
string.
* General error tracing. KBB_RAS1=ERROR
* Intensive error tracing. KBB_RAS1=ERROR (UNIT:kgb ALL)
* Maximum error tracing. KBB_RASI=ERROR (UNIT:kgb ALL) (UNIT:kra ALL)

Note: As this example shows, you can set multiple RAS tracing options in a single statement.

To set tracing for the Monitoring Agent for Lotus Domino, use UNIT:kgb ALL
4. Modify the value for Maximum Log Size Per File (MB) to change the log file size (changes LIMIT
value).
5. Modify the value for Maximum Number of Log Files Per Session to change the number of log files
per startup of a program (changes COUNT value).
6. Modify the value for Maximum Number of Log Files Total to change the number of log files for all
startups of a program (changes MAXFILES value).

7. Optional: Click Y (Yes) in the KDC_DEBUG Setting menu to log information that can help you
diagnose communications and connectivity problems between the monitoring agent and the
monitoring server. The KDC_DEBUG setting and the Maximum error tracing setting can generate a large
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amount of trace logging. Use these settings only temporarily, while you are troubleshooting problems.
Otherwise, the logs can occupy excessive amounts of hard disk space.

8. Click OK. You see a message reporting a restart of the monitoring agent so that your changes take
effect.

What to do next

Monitor the size of the Togs directory. Default behavior can generate a total of 45 - 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor can generate 45 - 60
MB of log data. See the “Procedure” section to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the Togs directory. Unlike the RAS1 log files
that are pruned automatically, other log types can grow indefinitely, for example, the logs in

that include a process ID number (PID).

Use collector trace logs as an additional source of troubleshooting information.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of trace
logging. Use these settings only temporarily while you are troubleshooting problems. Otherwise, the logs
can occupy excessive amounts of hard disk space.

Manually setting RAS trace parameters

You can manually edit the RAS1 trace logging parameters.

About this task

Agents use RASI1 tracing and generate the logs described in [Table 2 on page 7} The default RASI trace
level is ERROR.

Procedure
1. Open the trace options file:
* Windows systems:
install_dir\tmaitm6\KGBENV_instance name
* UNIX systems:
install dir /config/gb_instance name.config

2. Edit the line that begins with KBB_RAS1= to set trace logging preferences. For example, if you want
detailed trace logging, set the Maximum Tracing option: KBB_RAS1=ERROR (UNIT:kgb ALL) (UNIT:kra
ALL)

3. Edit the line that begins with KBB_RAS1_LOG= to manage the generation of log files:

* MAXFILES: The total number of files that are to be kept for all startups of a specific program. When
this value is exceeded, the oldest log files are discarded. The default value is 9.

* LIMIT: The maximum size, in megabytes (MB) of a RAS] log file. The default value is 5.
 IBM Software Support might guide you to modify the following parameters:

— COUNT: The number of log files to keep in the rolling cycle of one program startup. The default is
3.

— PRESERVE: The number of files that are not to be reused in the rolling cycle of one program
startup. The default value is 1.

Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory, log

file name, and the inventory control file directory and name. Do not modify these values or log
information can be lost.
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For the Monitoring Agent for Lotus Domino, each instance of the agent has unique trace settings on
Windows systems, but the three executable files for one instance do not have unique trace settings.
On UNIX and Linux, trace settings are global across the instances. No trace settings are available
for the LGO log for Windows, UNIX, or Linux systems.

4. Restart the monitoring agent so that your changes take effect.
What to do next

Monitor the size of the Togs directory. Default behavior can generate a total of 45 - 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor can generate 45 - 60
MB of log data. See the “Procedure” section to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the 1ogs directory. Unlike the RAS1 log files
that are pruned automatically, other log types can grow indefinitely, for example, the logs in

that include a process ID number (PID).
Use collector trace logs as an additional source of troubleshooting information.
Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of trace

logging. Use these settings only temporarily while you are troubleshooting problems. Otherwise, the logs
can occupy excessive amounts of hard disk space.

Dynamic modification of trace settings

You can dynamically modify the trace settings for an IBM Tivoli Monitoring component, such as, Tivoli
Enterprise Monitoring Server, Tivoli Enterprise Portal Server, most monitoring agents, and other
components. You can access these components, except for a few monitoring agents, from the tracing
utility.

Dynamic modification of the trace settings is the most efficient method, because you can do it without
restarting the component. Settings take effect immediately. Modifications by this method are not
persistent.

Note: When the component is restarted, the trace settings are read again from the .env file. Dynamically
modifying these settings does not change the settings in the .env files. To modify these trace settings
permanently, modify them in the .env files.

rasi
Run this command to modify the trace settings for a Tivoli Monitoring component.

The syntax is as follows:

rasl set|1list (UNIT|COMP: class_name ANY|ALL|Detail|ERROR|F1ow|INPUT|Metrics|OUTPUT|STATE)
{(UNIT|COMP: class_name ANY|ALL[Detail|ERROR|Flow|INPUT|Metrics|OUTPUT|STATE)}

You can specify more than one component class to which to apply the trace settings.

Command options

set
Turns on or off tracing depending upon the value of its parameters. If the parameter is ANY, it turns it
off. All other parameters turn on tracing based on the specified type or level.

list
Displays the default level and type of tracing that is set by default.
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Parameters

The parameters that determine the component classes to which to apply the trace settings are as follows:

COMP: class_name
Modifies the trace setting for the name of the component class, as specified by class_name , for
example, COMP:KDH. The output contains trace for the specified class.

UNIT: class_name
Modifies the trace setting for any unit that starts with the specified class_name value, for example,
UNIT: kra. The output contains trace for any unit that begins with the specified filter pattern.

The parameters that determine the trace level and type are as follows:

ALL
Displays all trace levels, including every trace point defined for the component. This setting might
result in a large amount of trace, so specify other parameters to exclude unwanted trace. You might
require the ALL parameter to isolate a problem, which is the equivalent to setting "Error Detail Flow
State Input Output Metrics".

ANY
Turns off tracing.

Detail
Displays detailed information about each function.

When entered with the Tist option, the trace is tagged with Det.

ERROR
Logs internal error conditions.

When entered with the 1ist option, the trace is tagged with ER. The output can also be tagged with
EVERYE+EVERYU+ER.

Flow
Displays control flow data for each function entry and exit.

When entered with the 1ist option, the trace is tagged with F1.

INPUT
Displays input data for each function.

When entered with the 1ist option, the trace is tagged with IN.

Metrics
Displays metrics on each function.

When entered with the 1ist option, the trace is tagged with ME.

OUTPUT
Displays output data for each function.

When entered with the 1ist option, the trace is tagged with OUT.

State
Displays the status for each function.

When entered with the Tist option, the trace is tagged with St.
Example

If you enter rasl set (COMP:KDH ALL) (COMP:ACF1 ALL) (COMP:KDE ALL), the trace utility turns on all
levels of tracing for all the files and functions for which KDH, ACF1, and KDE are the classes.
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kbbcrel.c, 400, May 29 2007, 12:54:43,
kbbcrnl.c, 400, May 29 2007, 12:54:42,
kdhblde.c, 400, May 29 2007, 12:59:34,
kdhOmed.c, 400, May 29 2007, 12:59:24, 1.1, KDH
kdhsrej.c, 400, May 29 2007, 13:00:06, 1.5, KDH

1.1, ~
1.
1.
1.
1.
kdhblfh.c, 400, May 29 2007, 12:59:33, 1.1, KDH
1.
1.
1.
1.
1.

1, *
1, KDH

kdhbloe.c, 400, May 29 2007, 12:59:38, 1.2, KDH
kdhslns.c, 400, May 29 2007, 13:00:08, 1.3, KDH
kbbacdl.c, 400, May 29 2007, 12:54:27, 1.2, ACFl
kbbaclc.c, 400, May 29 2007, 12:54:27, 1.4, ACFl
kbbacli.c, 400, May 29 2007, 12:54:28, 1.11, ACF1
vkdhsfcn.c, 400, May 29 2007, 13:00:11, 1.1, KDH

kdhserg.c, 400, May 29 2007, 12:59:53, 1.1, KDH
kdhblpr.c, 400, May 29 2007, 12:59:39, 1.1, KDH
kdhsgnh.c, 400, May 29 2007, 12:59:49, 1.1, KDH
kdhOuts.c, 400, May 29 2007, 12:59:23, 1.1, KDH
kdhsrsp.c, 400, May 29 2007, 13:00:13, 1.2, KDH
kdhslrp.c, 400, May 29 2007, 13:00:12, 1.1, KDH
kdhscsv.c, 400, May 29 2007, 12:59:58, 1.9, KDH
1.10, KDE

kdebbac.c, 400, May 29 2007, 12:56:50,

Turning on tracing

To use the tracing utility, you must use a local logon credential for the computer. This tracing method
uses the IBM Tivoli Monitoring Service Console. Access the Service Console by using a web browser.

About this task

When you start the Service Console, information is displayed about the components that are currently
running on that computer. For example, these components are listed as follows:

* Tivoli Enterprise Portal Server: cnp
* Monitoring Agent for Windows OS: nt
* Tivoli Enterprise Monitoring Server: ms

After you log on, you can type a question mark (?) to display a list of the supported commands. Use the
rasl command to modify trace settings. If you type this command in the field provided in the Service
Console window and click Submit, the help for this command is displayed.

Procedure
1. Open a web browser and enter the URL to access the Service Console.
http://hostname:1920

where hostname is the IP address or host name of the computer on which the IBM Tivoli Monitoring
component is running.

2. Click the hyperlink associated with the component for which you want to modify its trace settings.

Note: In the previous view, if you want to modify tracing for the Tivoli Enterprise Monitoring Server,
select IBM Tivoli Monitoring Service Console under Service Point: system.your host name_ms.

3. Enter a user ID and password to access the system. This ID is any valid user that has access to the
system.

4. Enter the command to turn on the required level of trace for the specified component classes or units.
rasl set (UNIT|COMP: class _name ALL|Flow|ERROR|Detail|INPUT|Metrics|OUTPUT|STATE)

{(UNIT|COMP: class_name ALL|Flow|ERROR|Detail|INPUT|Metrics|OUTPUT|STATE)}
For example, to turn on the control flow trace for the KDE, the command is:

rasl (COMP:KDE Flow)
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Turning off tracing

You can use the IBM Tivoli Monitoring Service Console to run the rasl command and dynamically turn

off tracing.

Procedure
1. Open a web browser and enter the URL to access the Service Console.
http://hostname:1920

where hostname is the IP address or host name of the computer on which the IBM Tivoli Monitoring

component is running.
2. Click the hyperlink associated with the component for which you want to modify its trace settings.

3. Enter a user ID and password to access the system. This ID is any valid user that has access to the
system.

4. Enter the command to turn off the required level of trace for the specified component classes or units.

rasl set (UNIT|COMP: class_name ANY)
{(UNIT|COMP: class_name ANY)}

For example, to turn off tracing for the kbbcrcd class of the Windows OS agent, the command is:
rasl set (UNIT:kbbcrcd ANY)

Setting trace parameters for the Tivoli Enterprise Console server

In addition to the trace information captured by IBM Tivoli Monitoring, you can also collect additional
trace information for the Tivoli Enterprise Console® components that gather event server metrics.

About this task

To collect this information, modify the .tec_diag_config file on the Tivoli Enterprise Console event
server. Use the steps in the following procedure to modify the event server trace parameters.

Procedure
1. Open the $BINDIR/TME/TEC/.tec_diag_config file in an ASCII editor.

2. Locate the entries that configure trace logging for the agent components on the event server. Two
entries are included, one for tec_reception and one for tec_rule:
# to debug Agent Utils
tec_reception Agent_Utils error /tmp/tec_reception
SP
# to debug Agent Utils
tec_rule Agent_Utils error /tmp/tec_rule

3. To gather additional trace information, modify these entries to specify a trace level of trace2:

# to debug Agent Utils
tec_reception Agent Utils  trace2 /tmp/tec_reception

SP
# to debug Agent Utils
tec_rule Agent_Utils trace2 /tmp/tec_rule

4. In addition, modify the Highest_Tevel entries for tec_rule and tec_reception:

tec_reception Highest_level trace2
SP
tec_rule Highest Tevel trace2

Chapter 2. Trace logging
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Chapter 3. Problems and workarounds

The known problems and workarounds are organized into types of problems that might occur with an
agent, for example installation and configuration problems and workspace problems.

You can resolve some problems by ensuring that your system matches system requirements. The most

up-to-date requirements are in the [Software product compatibility reports| (http://

publib.boulder.ibm.com/infocenter/prodguid /v1r0/clarity /index.html).

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.

Installation and configuration troubleshooting

Problems can occur during installation, configuration, and uninstallation of the agent.

See [Table 3| and [Table 4 on page 23| for information about these problems and solutions.

Table 3. Problems and solutions for installation and configuration

Problem

Solution

(UNIX only) During a command-line installation, you
choose to install a component that is currently installed,
and you see the following warning: WARNING - you are
about to install the SAME version of
"component_name" where component_name is the name of
the component that you are attempting to install.

Note: This problem affects UNIX command-line
installations. If you monitor only Windows
environments, you see this problem if you choose to
install a product component (for example, a monitoring
server) on a UNIX system.

You must exit and restart the installation process. You
cannot return to the list where you selected components
to install. When you run the installer again, do not
attempt to install any component that is currently
installed.

A problem can occur when you install and configure a
new monitoring agent on a computer where other agents
are running as described in this example:

* Agents are running on a computer and communicating
with a Tivoli Enterprise Monitoring Server, called
TEMS1.

* You install a new agent on the same computer and
you want this agent to communicate with a different
monitoring server, called TEMS2.

* When you configure the new agent to communicate
with TEMS2, all the existing agents are reconfigured
to communicate with TEMS2.

You must reconfigure the previously existing agents to
restore their communication connection with TEMS1. For
example, you can right-click the row for a specific agent
in the Manage Tivoli Enterprise Monitoring Services, and
select Reconfigure.

For more information about reconfiguration, see the IBM
Tivoli Monitoring Installation and Setup Guide.

© Copyright IBM Corp. 2005, 2016
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Table 3. Problems and solutions for installation and configuration (continued)

Problem

Solution

Diagnosing problems with product browse settings
(Windows systems only).

When you have problems with browse settings, complete
the following steps:

1. Click Start > Programs > IBM Tivoli Monitoring >
Manage Tivoli Enterprise Monitoring Services. The
Manage Tivoli Enterprise Monitoring Services
window is displayed.

2. Right-click the Windows agent and select Browse
Settings. A text window is displayed.

3. Click Save As and save the information in the text
file.

If requested, you can forward this file to IBM Software
Support for analysis.

A message similar to "Unable to find running CMS on
CT_CMSLIST" in the log file is displayed.

If a message similar to "Unable to find running CMS on

CT_CMSLIST" is displayed in the log file, the agent cannot

connect to the monitoring server. Confirm the following

points:

* Do multiple network interface cards (NICs) exist on
the system?

* If multiple NICs exist on the system, find out which
one is configured for the monitoring server. Ensure
that you specify the correct host name and port
settings for communication in the IBM Tivoli
Monitoring environment.

The system is experiencing high CPU usage.

Agent process: View the memory usage of the KGBCMA
process. If CPU usage seems to be excessive, restart the
monitoring agent.

Network cards: The network card configurations can
decrease the performance of a system. Each stream of
packets that a network card receives (assuming that it is
a broadcast or destined for the under-performing system)
must generate a CPU interrupt and transfer the data
through the I/O bus. If the network card in question is a
bus-mastering card, work can be offloaded and a data
transfer between memory and the network card can
continue without using CPU processing power.
Bus-mastering cards are 32-bit and are based on PCI or
EISA bus architectures.

After installing the Monitoring Agent for Lotus Domino
on a Windows system, you receive a message that the
Windows computer must be rebooted (KGB5039I). The
environment variables are not available in the system
environment.

Restart the system to make the system environment
variables available.

The Monitoring Agent for Lotus Domino fails to start
when installed on Solaris 10 with Upgrade 1.

A solution is not available for this problem.

When configuring the Monitoring Agent for Lotus
Domino, you receive the following warning message: An
agent with that name exists.

An instance name that is not valid might have been
provided, for example, "Agen</". Provide an instance
name that is valid.

When configuring the Monitoring Agent for Lotus
Domino, you receive a Java exception.

Avoid using parameters such as question marks (?),
slashes (/ and \), ampersand (&), and dollar signs ($) in
the instance name, Domino Server name, or notes.ini
file name.
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Table 3. Problems and solutions for installation and configuration (continued)

Problem

Solution

Unable to install the agent on a UNIX or Linux operating
system.

Add a NotesProgram entry to the notes.ini file. Issue
kgbconfing.sh again and start the agent.

You receive the following error message when
configuring an agent using itmemd config -A -0 xxxx
gb: This agent was previously configured using the
Host Specific Configuration option (the -t option on
the command line). To reconfigure, remember to
select CREATE HOST SPECIFIC CONFIGURATION' (on the
GUI) or use the command-line -t option.

This message does not have an adverse impact on the
instance configuration.

When installing locally (install.sh) to a UNIX or Linux
operating system, you receive the following error string:
Initializing ... ./install.sh[24]: <vrmf>: syntax
error awk: syntax error near line 1 awk: illegal
statement near line 1 awk: syntax error near line 1
awk: illegal statement near line 1 Initializing ...
chown: cannot access ~.=\\265\\263.(': No such file
or directory chmod: cannot access ~.=\\265\\263.(":
No such file or directory

Ignore this error.

You want to install a 32-bit and 64-bit Lotus Domino
agent on the same UNIX system.

The 32-bit and 64-bit installations must be in different
directories. Both installations must not use the default
candlehome directory of /opt/IBM/ITM.

You want to remotely deploy or locally install a 32-bit
Monitoring Agent for Lotus Domino to a 64-bit AIX®
system.

This function is currently not supported by IBM Tivoli
Monitoring.

Use the following steps to work around this problem:
1. Run the local installation of the Monitoring Agent for
Lotus Domino.

2. Select the 32-bit version under “Product packages are
available for the following operating systems and
component support categories(?.

3. After installation is complete, edit the ghaix5x3.ver
in install/registry.

After the last existing runArch = line, add the
following lines starting in column 1:

runArch = aix516
runArch = aix526
runArch = aix536

4. Save the gbaix5x3.ver or file.

When installing the Agent for Lotus Domino,
information about the "IBM JAVA information" and
"Choose installation drive for JAVA" panels are
corrupted.

This problem is a current limitation. Check future
releases or service levels of IBM Tivoli Monitoring for
this fix.

If you configure an instance of the agent for Lotus
Domino on a UNIX or Linux system with the same name
as the host name, other instances configured using the
GUI cannot connect to the monitoring server.

Configure the instances using itmemd config from the
command line.

21

Chapter 3. Problems and workarounds



Table 3. Problems and solutions for installation and configuration (continued)

Problem

Solution

You have a 32-bit Microsoft BizTalk Server agent V6.2.2
installed on a 32-bit or a 64-bit operating system. When
you configure the agent, if you specify false in the Use
Windows Authentication field on the Configuration for
the Application Status attribute group page, and you do
not have the required privileges for the BizTalkMgmtDb
database, no value is displayed for the attributes in the
Tivoli Enterprise Portal.

You must either have server-wide privileges for the SQL
Server or database-wide privileges for the
BizTalkMgmtDb database. If you have server-wide
privileges, you must have rights to the Public and
Sysadmin server roles. If you have database-wide
privileges, you must have rights to the db_owner and
db_datareader database roles.

The user ID and password that you type to access the
SQL server while configuring the Microsoft BizTalk
Server agent V6.2.2 is not retained on the Tivoli
Enterprise Portal Configuration panel when you
reconfigure the agent.

OR

The user ID and password that you type in the Tivoli
Enterprise Portal Configuration panel while configuring
the Microsoft BizTalk Server agent V6.2.2 is not reflected
on the Manage Tivoli Enterprise Monitoring Services
Configuration panel.

You must add the BizTalk agent V6.2.2 that is included
in the ITCAM for Microsoft Applications bundle to the
depot where the Tivoli Enterprise Monitoring Server is
located.

When you install an ITCAM for Microsoft Applications
32-bit agent on a computer that has a preinstalled 64-bit
version of the same agent, the following situations occur:

Situation 1: The 32-bit agent is not installed. However,
when you run the KinCinfo command, the 32-bit agent is
displayed in the list of installed components.

Situation 2: The preinstalled 64-bit agent stops running.

Situation 1: No solution is available for this problem.

Situation 2: Restart the 64-bit agent.

If you have installed a 64-bit agent for ITCAM for
Microsoft Applications, information about the agent
processes is not displayed in the Kinviewer window.

No solution is available for this problem at this time.

When you install a 32-bit agent for ITCAM for Microsoft
Applications, the following message is displayed under
the Install the following features list, :

Undefined GSK component:IBM GSKit Security Interface

Ignore this message and proceed with the installation.

You have preinstalled agents of earlier versions of IBM
Tivoli Monitoring for Microsoft Applications on your
computer. When you run the ITCAM for Microsoft
Applications installation wizard to upgrade the agent to
V6.2.2, the Select Features window displays a list of all
the agent features that you can install. The installed
agents are selected by default. If you do not want to
upgrade the installed features, you cannot clear the
default selection.

Run the setup.exe file of the Windows OS agent V6.2.2
or later to install the Tivoli Enterprise Monitoring Agent
Framework. Then, upgrade the preinstalled IBM Tivoli
Monitoring for Microsoft Applications agents.

While installing the ITCAM for Microsoft Applications
agent, though the Tivoli Enterprise Monitoring Agent
Framework is a mandatory feature, you can specify not
to install the Tivoli Enterprise Monitoring Agent
Framework. However, even if you specify not to install
the Tivoli Enterprise Monitoring Agent Framework, the
Tivoli Enterprise Monitoring Agent Framework is
installed.

No solution is available for this problem at this time.
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Table 3. Problems and solutions for installation and configuration (continued)

Problem

Solution

You have installed two 32-bit Microsoft Application
agents and the 32/64-bit Agent Compatibility Package
(ACP) from the ITCAM for Microsoft Applications 64-bit
agent. You cannot install additional 32-bit Microsoft
application agents on the same managed system.

Run the Windows OS agent V6.2.2, Fix Pack 2 setup.exe
file to install the 32/64-bit Agent Compatibility Pack
(ACP). You can also reinstall the ACP from the 64-bit
agent ITCAM for Microsoft Applications V6.2.2 folder.

After you upgrade ITCAM for Microsoft Applications
from an earlier version to V6.2.2, the following entries
are created in the Add or Remove Programs window:

» IBM Tivoli Monitoring for Microsoft Applications
* IBM Tivoli Monitoring

Ignore IBM Tivoli Monitoring for Microsoft
Applications in the Add or Remove Programs window.
If you want to modify or remove the installed agents in
IBM Tivoli Monitoring for Microsoft Applications, use
IBM Tivoli Monitoring from the Add or Remove
Programs window.

The configuration panel is blank on 64-bit Windows
systems where the Tivoli Enterprise Monitoring Agent
Framework (component GL) is version 06.23.00.00 or
06.23.01.00.

Check the GL component version by running kincinfo -t
GL from a Windows command line. Example:

%CANDLE_HOME%\InstallITM\kincinfo -t GL

If the GL component version is 06.23.00.00 or 06.23.01.00,
take one of the following actions:

* Preferred action: Upgrade the Windows OS Agent to
Version 6.2.3 Fix Pack 2.

* Alternate action: Install the Agent Compatibility (AC)
component from the IBM Tivoli Monitoring V6.2.3 Fix
Pack 1 media. See [Installing the Agent Compatibilityl|
|1 AC) Componen’_cl (http:/ /pic.dhe.ibm.com/infocenter/
tivihelp/v15r1/topic/com.ibm.itm.doc_6.2.3fp1/
itm623FP1_install199.htm#acpinstall).

Table 4. General problems and solutions for uninstallation

Problem

Solution

On Windows systems, uninstallation of IBM Tivoli
Monitoring fails to uninstall the entire environment.

Be sure that you follow the general uninstallation process
described in the IBM Tivoli Monitoring Installation and
Setup Guide:

1. Remove Tivoli Enterprise Monitoring Server
Application support by completing the following
steps:

a. Use Manage Tivoli Enterprise Monitoring
Services.

Select Tivoli Enterprise Monitoring Server.
Right-click and select Advanced.
Select Remove TEMS application support.

®o o0

Select the agent to remove its application support.

2. Uninstall the monitoring agents first, as in the
following examples:

* Uninstall a single monitoring agent for a specific
database.
-OR-

* Uninstall all instances of a monitoring product,
such as IBM Tivoli Monitoring for Databases.

3. Uninstall IBM Tivoli Monitoring.
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Table 4. General problems and solutions for uninstallation (continued)

Problem

Solution

The way to remove inactive managed systems (systems
whose status is OFFLINE) from the Navigator tree in the
portal is not obvious.

Use the following steps to remove, but not uninstall, an

offline managed system from the Navigator tree:

1. Click the Enterprise icon in the Navigator tree.

2. Right-click, and then click Workspace > Managed
System Status.

3. Right-click the offline managed system, and select
Clear offline entry.

To uninstall the monitoring agent, use the procedure
described in the IBM Tivoli Monitoring Installation and
Setup Guide.

IBM Tivoli Monitoring might not be able to generate a
unique name for monitoring components because of the
truncation of names that the product automatically
generates.

If the agent supports multiple instances, IBM Tivoli
Monitoring automatically creates a name for each
monitoring component by concatenating the subsystem
name, host name, and product code separated by colons
(subsystem_name:hostname:KGB).

Note: When you monitor a multinode system, such as a
database, IBM Tivoli Monitoring adds a subsystem name
to the concatenated name, typically a database instance
name.

The length of the name that IBM Tivoli Monitoring
generates is limited to 32 characters. Truncation can
result in multiple components having the same
32-character name. If this problem happens, shorten the
hostname portion of the name as follows:

1. Open the configuration file for the monitoring agent,
which is located in the following path:

¢ On Windows: install_dir\tmaitmé6\
Kproduct_codeCMA.INI. For example, the product
code for the Monitoring Agent for Windows OS is
NT. The file name is KNTCMA. INI.

* On UNIX and Linux: itm_home/config/
product_code.ini and product_code.config. For
example, the file names for the Monitoring Agent
for UNIX OS is ux.ini and ux.config.

2. Find the line that begins with CTIRA_HOSTNAME=.

3. Type a new name for host name that is a unique,
shorter name for the host computer. The final
concatenated name including the subsystem name,
new host name, and KGB, cannot be longer than 32
characters.

Note: You must ensure that the resulting name is
unique with respect to any existing monitoring
component that was previously registered with the
Tivoli Enterprise Monitoring Server.

4. Save the file.
5. Restart the agent.

An error message is displayed stating: The agent action
REMOVEINSTANCE failed with a return code of 3 for
product QB.

Do not manually remove the Microsoft BizTalk Server
agent instance. Instead, uninstall the Microsoft BizTalk
Server agent to remove the agent instance.

The software inventory tag for the agent on UNIX and
Linux systems is not removed during uninstallation of
the agent.

After uninstalling the agent, manually remove the file
named full name of agent.cmptag from the
$CANDLEHOME/properties/version/ directory.
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Table 4. General problems and solutions for uninstallation (continued)

Problem

Solution

You have installed the Windows OS agent V6.2.2 or later
on your computer. The Windows OS agent does not start
if you uninstall a 32-bit agent for ITCAM for Microsoft
Applications by using the following methods:

* The silent_agent.txt file

¢ The command: tacmd removeSystem -t agentcode -n
node

For example, tacmd removeSystem —t gp —n
Primary:MachineName:NT
* The Remove option on the Tivoli Enterprise Portal.

The following error message is displayed: The service
did not respond to the start or control request in a
timely fashion. KCICF5100E: Unable to start, see
Event Log for information.

Use the following steps to resolve this problem:

1. In the KGLWICMA.VER and KUIWICLI.VER files in the
InstalTITM/ver directory, lower the current VRMF
values.

For example, if the current value is 06220000, change
this value to 06210000.

2. Run the setup.exe file for the Windows OS agent to
install the Tivoli Enterprise Monitoring Agent
framework.

3. Start the Windows OS agent.

Note: If IBM Tivoli Monitoring is not displayed in the
Add or Remove Programs window, run the setup.exe
file for ITCAM for Microsoft Applications to install the
Tivoli Enterprise Monitoring Agent Framework. You can
find the setup.exe file in the Agent_64bit\WINDOWS
directory.

You have a 32-bit agent of ITCAM for Microsoft
Applications installed on your computer. If you uninstall
the 32-bit agent, two entries of IBM Tivoli Monitoring are
created in the Add or Remove Programs window in the
following situations:

* With the 32-bit agent, you have Windows OS agent
V6.2.2 or later installed on a managed system and you
uninstall the 32-bit agent from the Tivoli Enterprise
Portal or by using the command: tacmd removeSystem
-t <agentCode> -n <node>

* With the 32-bit agent, you have 64-bit agent of ITCAM
for Microsoft Applications installed on a managed
system and you uninstall the 32-bit agent using the
silent_agent.txt file.

In both the situations, when you uninstall the 32-bit
agent, the preinstalled agent stops running.

Restart the preinstalled agent. Ignore the IBM Tivoli
Monitoring entry for V6.2.1 in the Add or Remove
Programs window. To modify or remove the installed
agents, use the IBM Tivoli Monitoring entry for V6.2.2
in the Add or Remove Programs window.
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Table 4. General problems and solutions for uninstallation (continued)

Problem

Solution

When the agent is installed using group deployment,
deploygroup was run multiple times. The group
deployment starts and completes successfully, but there
were multiple entries in the Deploy Status Summary
workspace on the Tivoli Enterprise Portal. When the
command tried to install multiple times, the additional
installations were queued and then were in failed state
though the agent was deployed successfully.

Note:

* When the bundle group contains a single bundle and
the deployment group contains more than one
member (managed system of the same type as AIX or
Linux), the deployment is successful on both systems.

* When the bundle group contains more than one
bundle and the deploy group contains single or
multiple members, the deployment will be executed
on each group member (managed system) depending
on the members present in the bundle group and
deploy group.

* The command creates a transaction for each XX bundle
for each target system; the bundle matching the
operating system for the deployment member is
processed successfully; and remaining transactions
were in a queued or failed state.

There is no solution at this time.

Remote deployment troubleshooting

Problems can occur with remote deployment and removal of agent software using the Agent Remote

Deploy process.

contains problems and solutions related to remote deployment.

Table 5. Remote deployment problems and solutions

Problem

Solution

While you are using the remote deployment feature to
install the IBM Tivoli Composite Application Manager
Agent for Lotus Domino, an empty command window is
displayed on the target computer. This problem occurs
when the target of remote deployment is a Windows
computer. (For more information about the remote
deployment feature, see the IBM Tivoli Monitoring
Installation and Setup Guide.)

Do not close or modify this window. It is part of the
installation process and is dismissed automatically.

The removal of a monitoring agent fails when you use
the remote removal process in the Tivoli Enterprise
Portal desktop or browser.

This problem might occur when you attempt the remote
removal process immediately after you restart the Tivoli
Enterprise Monitoring Server. You must allow time for
the monitoring agent to refresh its connection with the
Tivoli Enterprise Monitoring Server before you begin the
remote removal process.

The Domino Server name can be parsed incorrectly when
remotely deploying the monitoring agent using the
canonical server name.

Use the Domino Server shortname xxx/yy for the
config.KGB_SERVER input parameter when using the
tacmd command.
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Table 5. Remote deployment problems and solutions (continued)

Problem

Solution

Remotely configuring a Monitoring Agent for Lotus
Domino instance overwrites an existing instance instead
of providing a message that the instance exists

Use tacmd 1istSystems before running itmemd addSystem
before configuring a new instance.

On Windows systems, if the Agent for Lotus Domino is
upgraded remotely, the agent instances configured before
upgrading are lost.

Run %CANDLE_HOME%\InstallITM\updategbinstance.bat to
restore and upgrade the instances.

Remote deployment might fail if the monitoring server
support, portal server support, and the Agent for Lotus
Domino support for the desktop and browser client are
installed on the same computer.

Deploy the Agent for Lotus Domino to a computer
without monitoring server support, portal server
support, and Agent for Lotus Domino desktop and
browser client support. After deploying without support,
install the support if required.

If you remotely deploy the BizTalk Server agent V6.2.2
and ITCAM for Microsoft Applications on a computer,
and log in as a user that does not have administrator
privileges, the agent is not deployed. The following error
message is displayed: The property
_WIN32_STARTUP_.LocalSystem is invalid for version
062200000 of the BizTalk agent.

You must have administrator privileges on the computer
where you are deploying the agent.

The IBM Tivoli Composite Application Manager for
Microsoft Cluster Server Agent, V622 displays data for
the attributes groups only on Windows Server 2008 R2
for the following attribute groups:

* Clustered Shared Volume

* Clustered Shared Volume IO
* Global update messages

* MRR Messages

* Network Reconnections

* Network Messages

* Resource Control Manager

* Resources Summary

The agent does not display the data on Windows Server
2003 and Windows Server 2008 for the above mentioned
attribute groups.

No solution is available for this problem at this time.

On zLinux servers, you cannot remotely configure the
Agent for Lotus Domino instance through the portal
client after upgrading to IBM Tivoli Monitoring V6.2.1,
Interim Fix 2.

Add the following lines to 1z.1ini under
$CANDLEHOME/config:

+ CTIRA_HOSTNAME=$RUNNINGHOSTNAME$
» CTIRA_SYSTEM NAME=$RUNNINGHOSTNAME$

Then restart the operating system monitoring agent.
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Agent troubleshooting

A problem can occur with the agent after it has been installed.

contains problems and solutions that can occur with the agent after it is installed.

Table 6. Agent problems and solutions

Problem

Solution

Log data accumulates too rapidly.

Check the RAS trace option settings, which are described
in [“Setting RAS trace parameters by using the GUI” on|
[page 12 The trace option settings that you can set on the
KBB_RAS1= and KDC_DEBUG= lines potentially generate large
amounts of data.

The following attribute groups and situations based on
these attribute groups are not supported on the BizTalk
Server 2004 and BizTalk Server 2006:

* BizTalk .NET Adapter for SAP

* BizTalk .NET Adapter for Oracle DB

* BizTalk .NET Adapter for Siebel

* BizTalk .NET Adapter for Oracle E-Business Suite
» BizTalk .NET Adapter for SQL

No solution is available for this problem at this time.

The attribute groups that belong to the Human Workflow
Services Navigator item and situations based on these
attribute groups are not supported on the BizTalk Server
2009. The BizTalk agent provides cross-link from the
Human Workflow Services Navigator item to the
Workflow Foundation workspace of the .NET Framework
agent. The BizTalk Server 2009 uses Windows Workflow
Foundation instead of using Human Workflow Services.

No solution is available for this problem at this time.

When using the F1 key or selecting Help > Contents and
Index, you receive a message in your Microsoft Internet
Explorer browser that states, "It seems javascript is
disabled in your browser, please enable it and reload
again, or click here to view without javascript." If you
select 'here', the Tivoli Enterprise Portal V6.1 Help is
displayed, but the agent help is not.

Ensure that the local site is added to the trusted site for
the browser, and then enable the javascript.

The following error messages are displayed:
* Functionality Test: Server not Responding

e In the ../logs/hostname_gb xxxxxxxx.log: The ID
file being used is: /local/notesdata/server.id
Enter password (press the Esc key to abort):

Follow the steps in “Clearing the Domino Server
password” in the IBM Tivoli Composite Application
Manager Agent for Lotus Domino Installation and
Configuration Guide to clear the password on the Domino
Server.

Historical data collection is not working on UNIX
operating systems.

Starting the Monitoring Agent for Lotus Domino as root
can prevent historical data collection from working.
Check the permissions on the following directory:
$CANDLEHOME/interp/gb/hist/instanceName. Use one of
the following steps if this directory was created as root:

* Change the ownership of this directory to the Domino
user ID and group for the InstanceName
—OR—

* Delete the history data file and restart using the
InstanceName Domino user ID, which recreates the

directory with the correct ownership. Do not delete the
directory.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

On UNIX or Linux systems, starting Manage Tivoli
Enterprise Monitoring Services fails and you receive the
following messages: The file access permissions do
not allow the specified action. install_Dir/bin/
CandleManage: install_Dir/logs/CandleManage.log
0403-005 Cannot create the specified file. A problem
occurred. See Togs/CandleManage.log for details.

Correct the permissions on the CandleManage. 1og file.
The permissions default to RW R R, or 644. Only the
owner has write access to this file unless you change the
file permissions. The owner is the user ID that was the
first user to start the window. You can change the
permissions of the log file to 666 to allow anyone to
write to the log. You can use the following command to
change the permissions: chmod 666 install_dir/logs/
CandleManage.log

Note: Consult your system administrator before
changing the file permissions.

When starting a Monitoring Agent for Lotus Domino
instance using itmcmd agent -o start gb, you receive the
following error: itmemd agent [-1] [ -h install_dir] [
-0 option ] [ -p option ] [-c] start|stop pc Use -c
option to NOT regenerate config file.

Include the (-0) instance option in the itmemd agent
command as shown in the following example, and rerun
the command: itmemd agent -o instance start gb

The kgbstart.sh script fails (kgbstart.sh <defunct>
process and where logs indicate that a library failed to
load).

The Notes® user must define the Notes group correctly.

The itmcmd manage command fails.

Using CandleManage, the Monitoring Agent for Lotus
Domino (kgb) has to be stopped and started using a
Notes ID. CandleManage.log on UNIX has permissions
rwx rxx rxx (644). If root starts CandleManage the first
time, when a non-root ID starts CandleManage the start
fails because CandleManage cannot reallocate the log file.
Change the log file permissions to rwx rwx rwx (666) so
any user can start CandleManage. (The permissions on
the executable are 777).

When running the itmemd manage command (previously
known as the CandleManage command), the Monitoring
Agent for Lotus Domino (kgb) must be stopped and
restarted by using a Notes ID. The CandleManage.log file
on UNIX systems has rwx rxx rxx (644) permissions. If a
root user ID runs the itmemd manage command the first
time, when a non-root IDruns the itmemd manage
command, the start fails because the command cannot
reallocate the log file. Change the log file permissions to
TwX TwX rwx (666) so that any user can run the itmemd
manage command. (Set the permissions on the itmemd
manage command to 777).

In the Availability Workspace, the status of the Domino
Server (using the NSPingServer API call) is not
responding and the Domino Server is up.

Check the kgbclient log for the error message returned
by the NSPingServer API call.

For UNIX systems, the log is:
hostname_gb_instance_name_kgbclient_timestamp-nn.log

For Windows systems, the log is:
hostname_gb_instance_name_KGBCLIENT instance_name_
timestamp-nn.log
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Table 6. Agent problems and solutions (continued)

Problem

Solution

The kgbclient process exits and is not restarted. No data
is returned to the workspaces. The Availability
workspace shows that the Domino Server is shutting
down.

When the Domino Server is shut down, the kgbclient
data collection process for the Monitoring Agent for
Lotus Domino must also be shut down and restarted
after the Domino Server has stopped. If the Domino
Server process fails to stop within a 5-minute time
period, then the kgbclient process is not restarted. To
correct this condition, the Monitoring Agent for Lotus
Domino must be stopped and restarted manually. This
action might require a forced shutdown of the Domino
Server using the nsd script to clean up hung processes
that were left behind by the incomplete shutdown of the
Domino Server.

When using the itmemd agent commands to start or stop
this monitoring agent, you receive the following error
message:

MKCIINO201E Specified product is not configured.

Include the command option -0 to specify the instance to
start or stop. The instance name must match the name
used for configuring the agent. For example:

./itmcmd agent -o Testl start two-
letter_product_code

For more information about using the itmemd
commands, see the IBM Tivoli Monitoring Command
Reference.

After restarting your computer containing the BizTalk
Server and Microsoft BizTalk Server agent, the agent
starts without loading certain Performance Counters. The
following attribute groups might not show data:

» All Adapters
* Host Throttling
* Messaging

¢ Orchestrations

1. After the computer restarts, recycle the Microsoft
BizTalk Server agent from the Manage Tivoli
Enterprise Services window. It captures each counter
and display data for each attribute group in the Tivoli
Enterprise Portal Client.

2. Mark the Microsoft BizTalk Server agent, denoted as
KQBCMA, as a dependent service for the BizTalk
host instance service "BTSSvc $host_instance_name".
The Microsoft BizTalk Server agent and BizTalk
Server start successfully and show the necessary data
for the attribute groups.

Note: Using this solution has the following
disadvantages:

* For each host instance created, you must modify
the monitoring agent service dependency each
time.

* If one of the BizTalk Host instance stops, the
Microsoft BizTalk Server agent also stops.

* If the Microsoft BizTalk Server agent contains
multiple Host Instances and one of Host Instance
services goes down, the Microsoft BizTalk Server
agent service goes into a stopped state.

3. Define custom situations for the above attribute
groups. After a situation is triggered, restart the
BizTalk agent to capture all performance objects.

The Performance Object Status query has an incomplete
description.

The query and Situation Editor windows can only
display a maximum of 210 characters for the description.
No solution is available for this problem at this time.

30

IBM Tivoli Composite Application Manager Agent for Lotus Domino Troubleshooting Guide




Table 6. Agent problems and solutions (continued)

Problem

Solution

Some of the performance counters are unavailable for
BizTalk 2004. The following performance counters do not
return any data:

* MessageBox

* File Adapter

* FIP Adapter

* SMTP Adapter
* HTTP Adapter
* SOAP Adapter
* MSMQ Adapter
* SQL Adapter

No solution is available for this problem at this time.

After creating subsequent, non-default Host Instances in
the Microsoft BizTalk Server agent, you might not be
able to see data rows for the newly created Host
Instances. These Host Instances might not be seen in the
following views:

* Adapters

* Host Throttling
* Messaging

* Orchestrations

After creating subsequent Host Instances for the
Microsoft BizTalk Server agent, restart the Microsoft
BizTalk Server agent service to view data for newly
created Host Instances in the Tivoli Enterprise Portal.

The Tivoli Enterprise Portal unexpectedly displays
negative values for the following attributes:

* Batches being processed (TDDS attribute group)

* Records being processed (TDDS attribute group)

* Events being processed (TDDS attribute group)

* Active Receive Locations (Messaging attribute group)
* Active Send Messages (Messaging attribute group)

No solution is available for this problem at this time.
Note: Other attributes can also display negative values
unexpectedly.

After restarting the Agent for Lotus Domino, the status
Domino Agent is starting and initializing, is
displayed and does not change.

Restart the monitoring agent. If the problem continues,
check the Agent for Lotus Domino log files for any
errors.

On Windows systems, if you delete the Agent for Lotus
Domino instance history directory $CANDLEHOME\TMAITM6\
Togs\History\KGB\instance_name, the agent can no
longer create history files after you restart the agent. The
Agent for Lotus Domino stops soon after.

Manually recreate the $CANDLEHOME\TMAITM6\10gs\
History\KGB\instance_name directory. Reconfigure the
historical data collection, and then restart the agent.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

A configured and running instance of the monitoring
agent is not displayed in the Tivoli Enterprise Portal, but
other instances of the monitoring agent on the same
system are displayed in the portal.

IBM Tivoli Monitoring products use Remote Procedure
Call (RPC) to define and control product behavior. RPC
is the mechanism that a client process uses to make a
subroutine call (such as GetTimeOfDay or
ShutdownServer) to a server process somewhere in the
network. Tivoli processes can be configured to use
TCP/UDP, TCP/IP, SNA, and SSL as the protocol (or
delivery mechanism) for RPCs that you want.

IP.PIPE is the name given to Tivoli TCP/IP protocol for
RPCs. The RPCs are socket-based operations that use
TCP/IP ports to form socket addresses. IPPIPE
implements virtual sockets and multiplexes all virtual
socket traffic across a single physical TCP/IP port
(visible from the netstat command).

A Tivoli process derives the physical port for IP.PIPE
communications based on the configured, well-known
port for the hub Tivoli Enterprise Monitoring Server.
(This well-known port or BASE_PORT is configured by
using the PORT:' keyword on the KDC_FAMILIES /
KDE_TRANSPORT environment variable and defaults to
'1918'".)

The physical port allocation method is defined as
(BASE_PORT + 4096*N), where N=0 for a Tivoli
Enterprise Monitoring Server process and N=({1, 2, ..., 15}
for another type of monitoring server process. Two
architectural limits result as a consequence of the
physical port allocation method:

* No more than one Tivoli Enterprise Monitoring Server
reporting to a specific Tivoli Enterprise Monitoring
Server hub can be active on a system image.

* No more than 15 IPPIPE processes can be active on a
single system image.

A single system image can support any number of Tivoli
Enterprise Monitoring Server processes (address spaces)
if each Tivoli Enterprise Monitoring Server on that image
reports to a different hub. By definition, one Tivoli
Enterprise Monitoring Server hub is available per
monitoring enterprise, so this architecture limit has been
reduced to one Tivoli Enterprise Monitoring Server per
system image.

No more than 15 IPPIPE processes or address spaces can
be active on a single system image. With the first limit
expressed earlier, this second limitation refers specifically
to Tivoli Enterprise Monitoring Agent processes: no more
than 15 agents per system image.

Continued on next row.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

Continued from previous row.

This limitation can be circumvented (at current
maintenance levels, IBM Tivoli Monitoring V6.1, Fix Pack
4 and later) if the Tivoli Enterprise Monitoring Agent
process is configured to use the EPHEMERAL IP.PIPE
process. (This process is IP.PIPE configured with the
'EPHEMERAL:Y' keyword in the KDC_FAMILIES /
KDE_TRANSPORT environment variable). The number of
ephemeral IP.PIPE connections per system image has no
limitation. If ephemeral endpoints are used, the
Warehouse Proxy agent is accessible from the Tivoli
Enterprise Monitoring Server associated with the agents
using ephemeral connections either by running the
Warehouse Proxy agent on the same computer or by
using the Firewall Gateway feature. (The Firewall
Gateway feature relays the Warehouse Proxy agent
connection from the Tivoli Enterprise Monitoring Server
computer to the Warehouse Proxy agent computer if the
Warehouse Proxy agent cannot coexist on the same
computer.)

When configuring an instance node using NLV
characters, after clicking OK, the window is not
displayed.

This problem is a current limitation. Check future
releases or service levels of IBM Tivoli Monitoring for
this fix.

No "space" between words is displayed for the strings in
the drop-down list of Advanced Filters panel.

This problem is a current limitation. Check future
releases or service levels of IBM Tivoli Monitoring for
this fix.

Names are truncated on the Properties panel.

Reopening the Properties panel might display the names
correctly.

If this solution does not work, this problem is a current
limitation with no solution. Check future releases or
service levels of IBM Tivoli Monitoring for this fix.

Simplified Chinese uses Traditional Chinese font on the
GUIL

This problem is a current limitation. Check future
releases or service levels of IBM Tivoli Monitoring for
this fix.

All text strings use the Traditional Chinese font on the
GUL however, help accessed through F1 might appear in
Simplified Chinese.
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Table 6. Agent problems and solutions (continued)

Problem

Solution

On UNIX or Linux systems, if the notes.log monitoring
does not work, and an error message is displayed similar
to the following message in the
hostname_gb_<instance_name>_kgbagent_timestamp-
nn.log file:
* (49E59AAB.0051-1:query.cpp,624,"Toad
_agents") Starting IRA agent for attribute group
Domino_Log_File<KGB>
* (49E59AAB.0052-1:1ogmonitorqueryclass
.cpp,403,"register
Callbacks") Failed to Toad kump610 shared Tibrary

1. If you have no Universal Agent on the computer
where the Agent for Lotus Domino resides, install the
latest Universal Agent. If Universal Agent is installed,
make sure that it is version 6.2.1 or higher.

2. Copy 1ibkum0610.so0, 1ibkump610.so, and
1ibkums1API.so files on the Universal Agent to the
Agent for Lotus Domino private library path.:

cp $CANDLEHOME/tmaitm6/<interp>/1ib/
1ibkum0610.so $CANDLEHOME/<interp>/gb/1ib
cp $CANDLEHOME/tmaitmé6/<interp>/1ib/
1ibkump610.so $CANDLEHOME/<interp>/gb/1ib
cp $CANDLEHOME/tmaitmé6/<interp>/1ib/
Tibkums1API.so $CANDLEHOME/<interp>/gb/1ib

For example, if the platform is SuSE Linux x86-32, and
CANDLEHOME is /opt/IBM/ITM, issue the following
commands:
cp /opt/IBM/ITM/tmaitm6/116263/1ib/1ibkum0610.s0
/opt/IBM/ITM/116263/gb/1ib
cp /opt/IBM/ITM/tmaitm6/1i6263/1ib/1ibkump610.s0
/opt/IBM/ITM/116263/gb/11ib
cp /opt/IBM/ITM/tmaitm6/116263/1ib/1ibkums1API.so
/opt/IBM/ITM/116263/gb/11ib

You want to use a name for your collection that includes
spaces in the path name.

The path name must be enclosed in quotation marks
("example name") as in the following examples:

* $CANDLEHOME/bin/tacmd addSystem -t gb -n
tivpbclp2:KUX -p INSTANCE="tivpbclp2"

» config.KGB_CHECK_DB_INCLUDE_PATH="«"
* config.KGB_IWHOSTNAME="none"

» config.KGB_NOTESINIPATH="/opt/ibm/DD
XH/Totus/notesdata"

* config.KGB_CHECK_DB_VIEW_CONFIG_FILE="none"
* config.KGB_LOG_EXCLUDE="none"

» config.KGB_CHECK_DB_EXCLUDE_PATH="none"

* config.KGB_LOG_INCLUDE="none"

+ config.KGB_LOGERROR="Log File is Full | Max
Count Exceeded"

* config.KGB_SERVER="tivpbclp2/ibm"
» config.KGB_CHECK DB_INTERVAL="3600"
* config.KGB_LOGFILE="none"

* config.KGB_IWPORT="none"

Hop
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Table 6. Agent problems and solutions (continued)

Problem

Solution

You have installed a 32-bit Windows OS agent and a
64-bit agent of ITCAM for Microsoft Applications on a
64-bit managed system. If the 64-bit agent abruptly stops
running, the Agent Management Service (AMS) fails to
restart the agent. The status of the agent in the Agents'
Management Status view changes to Unmanaged.

There are two possible solutions to this problem:

Solution 1: Restart the 64-bit agent and then use the
following steps to restart the AMS:

1. Right-click the agent, which is in the unmanaged
state, and click Take Action > Select.

2. From the Name list in the Action panel, select AMS
Start Management.

3. In the Destination Systems panel, select the managed
system node for the agent management that you
want to start.

4. Click OK.

Solution 2: Install the Windows OS agent V6.2.2, Fix
Pack 2.

Workspace troubleshooting

Problems can occur with general workspaces and agent-specific workspaces.

contains problems and solutions related to workspaces.

Table 7. Workspace problems and solutions

Problem

Solution

The process application components are available, but
the Availability status shows PROCESS_DATA_NOT_
AVAILABLE.

This problem occurs because the PerfProc performance
object is disabled. When this condition exists, IBM Tivoli
Monitoring cannot collect performance data for this
process. Use the following steps to confirm that this
problem exists and to resolve it:

1. In the Windows Start menu, click Run.

2. Type perfmon.exe in the Open field of the Run
window. The Performance window is displayed.

3. Click the plus sign (+) in the toolbar. The Add
Counters window is displayed.

4. Look for Process in the Performance object menu.
5. Complete one of the following actions:

 If you see Process in the menu, the PerfProc
performance object is enabled and the problem is
coming from a different source. You might need to
contact IBM Software Support.

* If you do not see Process in the menu, use the
Microsoft utility from the [Microsoft.com Operations|
to enable the PerfProc performance object.

The Process performance object becomes visible in
the Performance object menu of the Add Counters
windows, and IBM Tivoli Monitoring is able to
detect Availability data.

6. Restart the monitoring agent.
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Table 7. Workspace problems and solutions (continued)

Problem

Solution

The name of the attribute does not display in a bar chart
or graph view.

When a chart or graph view that includes the attribute is
scaled to a small size, a blank space is displayed instead
of a truncated name. To see the name of the attribute,
expand the view of the chart until sufficient space is
available to display all characters of the attribute name.

At the end of each view, you see the following Historical
workspace KFWITM220E error: Request failed during
execution.

Ensure that you configure all groups that supply data to
the view. In the Historical Configuration view, ensure
that data collection is started for all groups that supply
data to the view.

You start collection of historical data but the data cannot
be seen.

Use the following managing options for historical data
collection:

* Basic historical data collection populates the
Warehouse with raw data. This type of data collection
is turned off by default. For information about
managing this feature including how to set the interval
at which data is collected, see “Managing historical
data” in the IBM Tivoli Monitoring Administrator’s
Guide. By setting a more frequent interval for data
collection, you reduce the load on the system incurred
every time data is uploaded.

* Use the Summarization and Pruning agent to collect
specific amounts and types of historical data.
Historical data is not displayed until the
Summarization and Pruning monitoring agent begins
collecting the data. By default, this agent begins
collection at 2 a.m. daily. At that point, data is visible
in the workspace view. For information about how to
modify the default collection settings, see “Managing
historical data” in the IBM Tivoli Monitoring
Administrator’s Guide.

Historical data collection is unavailable because of
incorrect queries in the Tivoli Enterprise Portal.

The Sort By, Group By, and First/Last functions column
are not compatible with the historical data collection
feature. Use of these advanced functions makes a query
ineligible for historical data collection.

Even if data collection has started, you cannot use the
time span feature if the query for the chart or table
includes column functions or advanced query options
(Sort By, Group By, First / Last).

To ensure support of historical data collection, do not use
the Sort By, Group By, or First/Last functions in your
queries.

For information about the historical data collection
function, See “Managing historical data” in the IBM
Tivoli Monitoring Administrator’s Guide or the Tivoli
Enterprise Portal online help .

When you use a long process name in the situation, the
process name is truncated.

Truncation of process or service names for situations in
the Availability table in the portal display is the expected
behavior. The maximum name length is 100 bytes.

Regular (non-historical) monitoring data fails to be
displayed.

Check the formation of the queries you use to gather
data. For example, look for invalid SQL statements.

No IBM Tivoli IntelliWatch® data is displayed.

You must have IBM Tivoli IntelliWatch installed to see
data about this application.
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Table 7. Workspace problems and solutions (continued)

Problem

Solution

Navigator items and workspace titles are labeled with
internal names such as Kxx:KXX0000 instead of the correct
names (such as Disk), where XX and xx represent the
two-character agent code.

Ensure that application support has been added on the
monitoring server, portal server, and portal client.

For more information about installing application
support, see “Installing and enabling application
support” in the IBM Tivoli Monitoring Installation and
Setup Guide.

After restarting a system with the BizTalk Server and the
Microsoft BizTalk Server agent both configured to
autostart, the Microsoft BizTalk Server agent workspaces
do not contain data.

Restart the Microsoft BizTalk Server agent manually.

If you install an earlier version of the .Microsoft Net
Framework agent (V6.2.0 or earlier) on a workstation and
select a cross-linked workspace related to the Microsoft
.Net Framework agent, the following error message is
displayed on the portal:

KFWITMO81E: The Tink target cannot be found. The
link definition might be incorrect or the target is
unavailable.

Install the latest version of the Microsoft .Net Framework
agent that is available in the installation package.

The workspaces that are cross-linked with the Microsoft
.NET Framework agent do not show a filtered view for
the BizTalk-related instances.

Filter the BizTalk Server instances manually.

No predefined workspaces are available for attributes in
the following attribute groups:

» BizTalk .NET Adapter for SAP

* BizTalk .NET Adapter for Oracle DB

* BizTalk .NET Adapter for Siebel

* BizTalk .NET Adapter for Oracle E-Business Suite
» BizTalk .NET Adapter for SQL

You can create workspaces for attributes in these
attribute groups.

Data collected from superseded attribute groups are not
visible in a workspace.

Data is only collected every 30 seconds. If you change
from the 64-bit version of the workspace to the 32-bit
version of the workspace before 30 seconds, some of the
data is returned blank.

You have installed a 32-bit agent for ITCAM for
Microsoft Applications on a computer where a 64-bit
Windows OS agent V6.2.2, Fix Pack 1 is installed. On the
Tivoli Enterprise Portal, when you expand the Windows
OS node, and select the Agent Management Services
navigator item, the installation path of the agent is not
correctly displayed in the Agents' Management
Definitions view. Also, no data is displayed for the agent
version and the build number in the Agents'
Management Status view.

Upgrade the Windows OS agent from V6.2.2, Fix Pack 1
to V6.2.2, Fix Pack 2.

If the 32-bit OS agent and a 64-bit Microsoft Application
agent are installed on the same managed system, Agent
Management Services data is not displayed in the
Agent's Runtime Status view of the agent. The Agent's
Runtime Status view is available in the Agent
Management Services workspace.

No solution is available for this problem at this time.
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Table 7. Workspace problems and solutions (continued)

Problem

Solution

You have installed the ITCAM for Microsoft Applications
agent and the Windows OS agent in the IPV6
environment. In the Agent Management Services
navigator, the IP address in the Agents' Runtime Status
view is displayed in the IPV4 format instead of the IPV6
format.

No solution is available for this problem at this time.

You have installed the Tivoli Enterprise Monitoring
Server on z/OS®. In the Configuration panel of the
History Collection Configuration window, if you have
selected TEMS from the Collection Location list, the
Tivoli Enterprise Portal does not display historical data
for the following attribute groups:

* ASP NET Applications

* Availability

* Event Log

* Performance Object Status

¢ Search

Reconfigure the history collection, and set the collection
location as TEMA for these attribute groups.

Situation troubleshooting

Problems can occur with situations and situation configuration.

contains problems and solutions for situations.

Table 8. Situation problems and solutions

Problem

Solution

Monitoring activity requires too much disk space.

Check the RAS trace logging settings that are described
in [“Setting RAS trace parameters by using the GUI” on|
[page 12 For example, trace logs grow rapidly when you
apply the ALL logging option.

Monitoring activity requires too many system resources.

See the information about disk capacity planning for
historical data in the User Interface Reference for the
agent for a description of the performance impact of
specific attribute groups. If possible, decrease your use of
the attribute groups that require greater system
resources.

A formula that uses mathematical operators appears to
be incorrect. For example, if you were monitoring a
Linux system, the formula that calculates when Free
Memory falls under 10 percent of Total Memory does
not work: LT #'Linux_VM_Stats.Total_Memory' / 10

This formula is incorrect because situation predicates
support only logical operators. Your formulas cannot
have mathematical operators.

Note: The Situation Editor provides alternatives to math
operators. In the example, you can select the % Memory
Free attribute and avoid the need for math operators.

You want to change the appearance of situations when
they are displayed in the navigation tree.

1. Right-click an item in the navigation tree.

2. Click Situations in the menu. The Situation Editor
window is displayed.

3. Select the situation that you want to modify.

4. Use the State menu to set the status and appearance
of the Situation when it triggers.

Note: The State setting is not related to severity
settings in the Tivoli Enterprise Console.
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Table 8. Situation problems and solutions (continued)

Problem

Solution

When a situation is triggered in the Event Log attribute
group, it remains in the Situation Event Console as long
as the event ID entry is present in the Event Log
workspace. When this event ID entry is removed from
the Event Log workspace on the Tivoli Enterprise Portal,
the situation is also cleared even if the actual problem
that caused the event is not resolved, and the event ID
entry is also present in the Windows Event Viewer.

A timeout occurs on the cache of events for the NT Event
Log group. Increase the cache time of Event Log
collection to meet your requirements by adding the
following variable and timeout value to the KpcENV file
for the agent (where pc is the two-letter product code):
CDP_NT_EVENT_LOG_CACHE_TIMEOUT=3600

This variable determines how long events from the NT
Event Log are kept.

Events cannot be displayed in the (Tivoli Enterprise
Console) view when a situation name is longer than 31
bytes. The situation name might appear truncated in the
message column.

The situation name must be no more than 31 bytes long
and cannot contain the hyphen (-) character.

Recreate the situation using the specifications described
in the preceding row.

After changing a situation name, the TEC (Tivoli
Enterprise Console) view displays the original situation
name in the message column.

Use Create Another to create a new situation.
—OR-

Use situation_fullname in the Event Detail view to
check the actual situation name. Complete the following
steps to access the event detail view:

1. Select the event.

2. Click Details.

3. Select the Attribute list tab and scroll the attribute
list panel to situation_fullname.

In the Situation Formula Editor, text strings overlap or
are not displayed correctly.

This problem is a current limitation. Check future
releases or service levels of IBM Tivoli Monitoring for
this fix.

When the Agent for Lotus Domino is upgraded from
version 6.1 to 6.2.1, the situation associations might be
lost if the monitoring server and portal server are
installed on Windows.

Reassociate the situation manually.

If the Expert Advice for a situation contains a hyperlink
to an external website (for example, a Microsoft TechNet
website) and you click the hyperlink, the website opens
in an external window. However, the external window
stops responding.

The external window responds after you close the
Preview window and Situation Editor window.

The situation for a specific agent is not visible in the
Tivoli Enterprise Portal.

Open the Situation Editor. Access the All managed
servers view. If the situation is not displayed, confirm
that the monitoring server has been seeded for the agent.
If not, seed the server, as described in the IBM Tivoli
Monitoring Installation and Setup Guide.

The monitoring interval is too long.

Access the Situation Editor view for the situation that
you want to modify. Check the Sampling interval area in
the Formula tab. Adjust the time interval as required.

The situation did not activate at startup.

Manually recycle the situation as follows:

1. Right-click the situation and select Stop Situation.
2. Right-click the situation and select Start Situation.
Note: You can permanently avoid this problem by

selecting the Run at Startup check box of the Situation
Editor view for a specific situation.
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Table 8. Situation problems and solutions (continued)

Problem

Solution

The situation is not displayed.

Click the Action tab and check whether the situation has
an automated corrective action. This action can occur
directly or through a policy. The situation might be
resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event did not occur even though the predicate
was correctly specified.

Check the logs, reports, and workspaces.

A situation fires on an unexpected managed object.

Confirm that you distributed and started the situation on
the correct managed system.

The product did not distribute the situation to a
managed system.

Click the Distribution tab and check the distribution
settings for the situation.

The situation does not fire.

This problem can be caused when incorrect predicates
are present in the formula that defines the situation. For
example, the managed object shows a state that normally
triggers a monitoring event, but the situation is not true
because the wrong attribute is specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula area
of the window:

* The attributes that you intend to monitor are
specified in the formula.

* The situations that you intend to monitor are
specified in the formula.

* The logical operators in the formula match your
monitoring goal.

* The numeric values in the formula match your
monitoring goal.

b. (Optional) Select the Show detailed formula
check box to see the original names of attributes
in the application or operating system that you
are monitoring.

c. Click OK to dismiss the Show formula window.

2. (Optional) In the Formula area of the Formula tab,
temporarily assign numeric values that immediately
trigger a monitoring event. The triggering of the
event confirms that other predicates in the formula
are valid.

Note: After you complete this test, you must restore
the numeric values to valid levels so that you do not
generate excessive monitoring data based on your
temporary settings.

For additional information about situations that do not
fire, see “Situations are not firing” in the IBM Tivoli
Monitoring Troubleshooting Guide.

Situation events are not displayed in the Events Console
view of the workspace.

Associate the situation with a Navigator item.

Note: The situation does not need to be displayed in the
workspace. It is sufficient that the situation is associated
with any Navigator item.
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Table 8. Situation problems and solutions (continued)

Problem

Solution

You do not have access to a situation.

Note: You must have administrator privileges to
complete these steps.

1.

Click Edit > Administer Users to access the
Administer Users window.

In the Users area, select the user whose privileges
you want to modify.

In the Permissions tab, Applications tab, and
Navigator Views tab, select the permissions or
privileges that correspond to the user role.

4. Click OK.
A managed system seems to be offline. 1. Select Physical View and click the Enterprise Level of
the navigator tree.
2. Click View > Workspace > Managed System Status
to see a list of managed systems and their status.
3. If a system is offline, check network connectivity and

the status of the specific system or application.

Associations of custom situations with navigator items
break after upgrading the agent support.

Create the associations again by completing the
following steps:

1.

The situation is associated with the navigator item.

Right-click the navigator item, and then click
Situations. A list of situations that are associated with
the navigator item is displayed.

Note: If the custom situation that you want to
associate is available in the list, ignore remaining
steps.

Click the Set Situation filter criteria icon.

Select the Eligible for Association check box, and
then click OK. A list of situations is displayed.

Right-click the situation that you want to associate
with the navigator item, and then click Associate.

Take Action commands troubleshooting

Problems can occur with Take Action commands.

contains problems and solutions that can occur with Take Action commands.

When each Take Action command runs, it generates a log file listed in [Table 2 on page 7}

Table 9. Take Action commands problems and solutions

Problem

Solution

Take Action commands often require several minutes to
complete.

Allow several minutes. If you do not see a message
advising you of completion, try to run the command
manually.
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Table 9. Take Action commands problems and solutions (continued)

Problem

Solution

Situations fail to trigger Take Action commands.

Attempt to manually run the Take Action command in
the Tivoli Enterprise Portal. If the Take Action command
works, look for configuration problems in the situation.
See [“Situation troubleshooting” on page 38.|If the Take
Action command fails, for general information about
troubleshooting Take Action commands, see the IBM
Tivoli Monitoring Troubleshooting Guide.
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Chapter 4. Support information

If you have a problem with your IBM software, you want to resolve it quickly.

IBM provides the following ways for you to obtain the support you need:
Online
The following websites contain troubleshooting information:
+ Go to the [IBM Software Support website| (http:/ /www.ibm.com/support/entry/portal/
software) and follow the instructions.

* Go to the|Application Performance Management Wiki| (http:/ /www.ibm.com/developerworks/
servicemanagement/apm/index.html). Feel free to contribute to this wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to the IIBM Support Assistant Website| (http:/ /www.ibm.com/software/support/isa).
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Chapter 5. Informational, warning, and error messages
overview

Messages relay information about how the system or application is performing and can alert you to
exceptional conditions when they occur.

Messages are sent to an output destination, such as a file, database, or console screen.

If you receive a warning or error message, you can do one of the following actions:
* Follow the instructions listed in the Detail window of the message if this information is included there.
* Consult the message details listed in this topic to see what action you can take to correct the problem.

* Consult the message log for message ID, text, time, and date of the message, as well as other data you
can use to diagnose the problem.

Message format

The message format contains a message ID and text, an explanation, and an operator response.
Agent messages have the following format:

Message ID and text
Explanation
Operator Response

The message ID has the following format:
CCC####severity

where:

CCC  Prefix that indicates the component to which the message applies. The following components are
used:

KXX Three-character product code for the agent.
#HH  Number of the message

severity
Severity of the message. Three levels of severity are used:

I Informational messages provide feedback about something that happened in the
product or system that might be important. These messages can provide guidance
when you are requesting a specific action from the product.

W Warning messages call your attention to an exception condition. The condition
might not be an error but can cause problems if not resolved.

E Error messages indicate that an action cannot be completed because of a user or
system error. These messages require user response.

The Text of the message provides a general statement regarding the problem or condition that occurred.
The Explanation provides additional information about the message and the possible cause for the
condition. The Operator Response provides actions to take in response to the condition, particularly for
error messages (messages with the "E" suffix).
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Note: Many message texts and explanations contain variables, such as the specific name of a server or
application. Those variables are represented in this topic as symbols, such as "&1." Actual messages
contain values for these variables.

Agent messages
The following messages apply to IBM Tivoli Composite Application Manager Agent for Lotus Domino.

KGB5023I
The Domino Server service was started.

Explanation:
The Domino Server service was started.

Operator response:
None.

KGB5024E
The Domino Server service was not started.

Explanation:
The Domino Server service was not started.

Operator response:
None.

KGB50311
Responding

Explanation:
The Domino Server is responding.

Operator response:
None.

KGB50321
Not Responding

Explanation:
The Domino Server is not responding.

Operator response:
None.

KGB50331
Responding

Explanation:
At least one server in the cluster is responding.

Operator response:
None.

KGB50341
Not Responding

Explanation:
All Domino Servers in the cluster are not responding.

Operator response:
None.

KGB50351
Does Not Exist
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Explanation:
The Domino Server is not in a cluster.

Operator response:
None.

KGB50361
Does Not Exist

Explanation:
The notes.ini file was not found using the path specified.

Operator response:
Reconfigure the instance for the correct local full path to the notes.ini file.

KGB50371
kgbconfig.sh must be run on the Monitoring Agent for Lotus Domino

Explanation:
The kgbconfig.sh shell script must be run on the Monitoring Agent for Lotus Domino
prior to starting the first instance.

Operator response:
Login to the system where the Monitoring Agent for Lotus Domino is installed, and run
the kgbconfig.sh shell script.

KGB50381
The Monitoring Agent for Lotus Domino must be started as the Domino user.

Explanation:
When starting the Monitoring Agent for Lotus Domino, you must use the Domino User
ID.

Operator response:
Switch to the Domino User ID prior to starting the Monitoring Agent for Lotus Domino.

KGB50391
The Windows computer must be rebooted.

Explanation:
After installation of the Monitoring Agent for Lotus Domino on a Windows computer, the
computer must be rebooted to pick up the new environment variables.

Operator response:
Reboot the Windows computer, and restart the Monitoring Agent for Lotus Domino.

KGB50401
Re-cycling Domino agent.

Explanation:
The Domino Server is shutting down. The Monitoring Agent for Lotus Domino data
collection and availability has stopped until the Domino Server has stopped. After the
Domino Server has stopped completely, the monitoring agent data collection and
availability restarts automatically.

Operator response:
None.

KGB50411
Domino agent is starting and initializing.

Explanation:
The Monitoring Agent for Lotus Domino is in the process of starting. After the
monitoring agent has started completely, the agent availability is initialized.
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Operator response:
None.

KGB50421
Restricted.

Explanation:
The Domino Server is RESTRICTED in the cluster.

Operator response:
None.

KGB50431
Some but not all other Domino servers responding in the cluster.

Explanation:
Some Domino servers in the cluster are not available.

Operator response:
None.

KGB50441
Only one Domino server responding in the cluster.

Explanation:
Only one Domino server in the cluster is available.

Operator response:
None.

KGB5050E
intelliwatch/iwparam.nsf database not found or Domino Server is not responding.

Explanation:
The attempt to open the intelliwatch/iwparam.nsf database failed, or the Domino Server
is not responding.

Operator response:
Start the Domino Server and make sure the intelliwatch/iwparm.nsf database exists.

KGB5051E
A failure occurred writing to the intelliwatch/iwparam.nsf database.

Explanation:
The attempt to write to the intelliwatch/iwparam.nsf database failed.

Operator response:
Determine the error code from the logs written to the intelliwatch/iwparm.nsf database.
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Appendix. ITCAM for Applications documentation library

Various publications are relevant to the use of ITCAM for Applications.

For information about how to access and use the publications, see [Using the publications|
(http:/ /pic.dhe.ibm.com/infocenter/tivihelp /v61rl/topic/com.ibm.itm.doc_6.3/common/
using_publications.htm).

To find publications from the previous version of a product, click Previous versions under the name of
the product in the Contents pane.

Documentation for this product is in the [[TCAM for Applications Information Center|
(http:/ /publib.boulder.ibm.com/infocenter/tivihelp /v24r1/topic/com.ibm.itcama.doc_7.2.1/
welcome_apps721.html):

* Quick Start Guide
* Offering Guide

¢ Download instructions

* Links to Prerequisites

* Installation and Configuration Guide for each agent
* Link to Reference information for each agent

* Link to Troubleshooting Guide for each agent

Prerequisite publications

To use the information about the agents effectively, you must have some prerequisite knowledge.

See the following information at the [[BM Tivoli Monitoring Information Center] (http:/ /pic.dhe.ibm.com/
infocenter/tivihelp /v61rl/index.jsp) to gain prerequisite knowledge:

* IBM Tivoli Monitoring Administrator’'s Guide
* IBM Tivoli Monitoring Installation and Setup Guide
* IBM Tivoli Monitoring High Availability Guide for Distributed Systems

* IBM Tivoli Monitoring: Installation and Configuration Guides for the following agents: Operating
System agents and Warehouse agents

+ IBM Tivoli Monitoring: User's Guides for the following agents: Agentless OS monitors, Log file agent,
System p agents, Systems Director base agent

» IBM Tivoli Monitoring Agent Builder User’s Guide
* IBM Tivoli Monitoring Command Reference

* IBM Tivoli Monitoring: Messages

* IBM Tivoli Monitoring Troubleshooting Guide

+ IBM Tivoli Monitoring: References for the following agents: Operating System agents and Warehouse
agents

+ IBM Tivoli Monitoring: Troubleshooting Guides for the following agents: Operating System agents and
Warehouse agents

* Tivoli Enterprise Portal User’s Guide

Related publications

The publications in related information centers provide useful information.
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See the following information centers, which you can find by accessing [Tivoli Documentation Centrall
(https:/ /www.ibm.com/developerworks/community /wikis/home?lang=en#! /wiki/Tivoli
%20Documentation%?20Central):

* Tivoli Monitoring

* Tivoli Application Dependency Discovery Manager
* Tivoli Business Service Manager

* Tivoli Common Reporting

* Tivoli Enterprise Console

* Tivoli Netcool/OMNIbus

Tivoli Monitoring Community on Service Management Connect

Service Management Connect (SMC) is a repository of technical information that is organized by
communities.

Access Service Management Connect at [https:/ /www.ibm.com/developerworks/servicemanagement,

For information about Tivoli products, see the [Application Performance Management communityl|
(http:/ /www.ibm.com/developerworks/servicemanagement/apm/index.html).

Connect, learn, and share with Service Management professionals. Get access to developers and product
support technical experts who provide their perspectives and expertise. You can use SMC for these
purposes:

* Become involved with transparent development, an ongoing, open engagement between other users
and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

* Connect one-on-one with the experts to collaborate and network about Tivoli and the (enter your
community name here) community.

* Read blogs to benefit from the expertise and experience of others.
* Use wikis and forums to collaborate with the broader user community.

Other sources of documentation

You can obtain additional technical documentation about monitoring products from other sources.

See the following sources of technical documentation about monitoring products:

« [IBM Integrated Service Management Library] (http:/ /www.ibm.com/software/brandcatalog/
ismlibrary/) is an online catalog that contains integration documentation as well as other
downloadable product extensions.

« [IBM Redbook publications| (http:/ /www.redbooks.ibm.com/) include Redbooks® publications,
Redpapers, and Redbooks technotes that provide information about products from platform and
solution perspectives.

. (http:/ /www.ibm.com/support/entry/portal/software), which are found through the IBM
Software Support website, provide the latest information about known product limitations and
workarounds.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of

the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
274A/101

11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming
to IBM’s application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© IBM 2009. Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2009. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
[Copyright and trademark information| (www.ibm.com/ legal/copytrade.shtml).

dvd

COMPATIBLE

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s user name for purposes of session management, authentication, and single sign-on
configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM’s Privacy Policy at fhttp://www.ibm.com /privacy|and IBM’s Online Privacy Statement at
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http:/ /www.ibm.com /privacy/details| the section entitled “Cookies, Web Beacons and Other
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at
http:/ /www.ibm.com /software /info/product-privacy}
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